USERS

Users
Overview
By default casual visitors are allowed to register themselves on your website to gain access to
additional resources. For example, registered users might be allowed to submit resources or
simulation tools. Your website implements a user registration policy which can be adapted to
suit your particular requirements so you decide what additional resources are made available.
You can disable user registration altogether if you prefer.
Users register themselves on your website using the Register link typically found in the upper
right-hand portion of every page (position may vary). Once registered, users will log in to your
website by entering their username and password using the login form found at
http://yourhub.org/login. There are also links on the form to manage users who forget their
usernames or passwords.
See Configuring Registration to learn more about changing registration settings.
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Members
Members Breakdown
A breakdown of all the tabs on the /administrator interface inside of User: Members.
Members: Manage all member accounts
Notes: Manage user notes and note categories
Access: Manage access levels
Points: Manage user points
Passwords: Set and manage password rules
Quotas: Manage user quotas for tool usage
Registration: Manage registration process
Import: Import a CSV file of new users
Export: Download CSV of all users
Plugins: Manage all member related plugins

Members: Editing an Account
Note: Editing of users is done through the HUBzero Members Manager component, not the
User manager. Any changes made via the Members Manager will also be reflected in the User
tables. Making changes with the User Manager can lead to data becoming out of sync.
1. First login to /administrator
2. Once logged in, hover over Users and select Members from the drop-down

3. You should now be presented with a list of all the members on your site
1. There are a variety of methods to find the specific person you wish to edit:
Searching or Manually scrolling through the list to find the use
4. Once found, click the person's name to open up their profile
1. Account: General details about the users account and assigned access groups
2. Profile: Profile details
3. Password: Where an administrator can manually reset a user's password and
check on how many days are left before current password expires
1. Warning: If you have an automatic password filler turned on in your
browser, check this section if you are editing a user's account before
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saving for you might reset their password with one of your saved
passwords
4. Groups: List of groups that the user is involved in either as a member or
manager
5. Hosts: List of hosts that the user has access
6. Messaging: The user's messaging settings
5. Once you feel ready to save your changes, scroll back to the top of the page and
click Save (the icon that looks like a floppy disk) in the upper right portion of the page

Members: Manually Confirming a User
Users by default have the option to confirm their accounts unless an administrator changes this
to administrator approval only. An administrator will need to follow these steps to confirm any
new users:
1.
2.
3.
4.
5.

Navigate to /administrator and hover over the Users tab
Click Members from the drop-down
Search for the user you wish to confirm
Check the box beside their account and click the Confirm button
The user's account will be confirmed

Members: Clearing Existing Terms of Use Agreements
When terms of use are changed on the hub, it may be necessary to require users to re-accept
the new terms. To reset all existing agreements, and force re-acceptance, follow these steps:
1.
2.
3.
4.

Go to /administrator interface
Navigate to the Users tab and select Members from the drop-down
Click the Reset terms of use agreements for all users button
Navigate to the frontend of the Hub and login to double check that the Terms &
Conditions acceptance pop-up appears
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Members: Blocking a User's Account
Sometimes spammers can attack your Hub and create multiple accounts. In order to prevent the
spammers from access these accounts again, you can block their accounts. This also is a way
to
"unpublish" accounts of users who don't wish to have accounts on the Hub anymore versus
deleting their account. This way, if they ever need access again, you only have to unblock them.
Follow these steps to block a user's account:
1.
2.
3.
4.
5.

Navigate to /administrator and hover over the Users tab
Click Members from the drop-down
Search for the user you wish to confirm
Check the box beside their account and click the Block button
The user's account will be blocked

User Manager: Customize Profile
Allows an administrator to define profile/registration fields. To edit the profile schema, navigate
to the Members Manager (Users ? Members). Then click the button in the toolbar labeled
Profile. In this screen, you have the ability to define user profile fields, if said fields are required
or optional, what values are allowable, and what fields are dependent upon a value from
another field being chosen.
Field Type Breakdown:
Text
A single-line textbox.
Paragraph
A multi-line textbox (a.k.a. textarea).
Checkboxes
A list of options where the user may select one or more.
Multiple Choice
A list of options where the user can only choose one of the available options.
Date/Time
A textbox specifically for entering timestamps.
Dropdown
A dropdown (select box) of options where the user can only choose one of the available
options.
Country
A dropdown (select box) of countries. The list of countries is automatically populated.
Website
A textbox specifically for entering URLs.
Hidden
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A hidden input.
ORCID
A textbox for entering entering ORCIDs.

Toolbar Breakdown:
Save. Saves the user and stays in the current screen.
Save & Close. Saves the user and closes the current screen.
Save & New. Saves the user and keeps the editing screen open and ready to create
another user.
Cancel/Close. Closes the current screen and returns to the previous screen without
saving any modifications you may have made.
Help. Opens this help screen
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How to Build with the Profile Manager:
1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down
2. Click the Profile button
3. Manage the current Profile breakdown with the following actions:
1. Add a new field:
1. Select the field type then fill in the label information while under the Edit
field section
2. Determine the Access level and the information will automatically save
2. Duplicate a field:
1. Hover over the field you want to duplicate and then click the Duplicate
field button
3. Remove a field:
1. Hover over the field you want to remove and then click the Remove field
button
4. Move fields:
1. Select the field you want to move and drag it up or down depending on
your preference
4. Click Save & Close to save your changes

Notes
Notes are a function where users can create and store notes on the Hub. On the /administrator
interface, an administrator can manage the notes created by users.
User Notes: Where an administrator can view notes make by other users and edit,
approve, publish, unpublish, along with other actions to curate the notes
Note Categories: Where an administrator can create new note categories and batch
process selected categories

Access
An area where access groups can be managed. Access groups are the various permission
levels assigned to different groups of users based on their roles in the Hub. Generic default
levels are: Public, Manager, Administrator, Registered, Author, Editor, and Publisher. These
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levels are broken up by the levels of responsibility and what the access the group has to
different areas of the Hub. An administrator can see the number of users in the group in the
Users in Group column.

An administrator can add new access groups by clicking the New button and following these
steps:
1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down
2. Inside of Members, select the Access tab and click the New button
3. Add a Group Title and then select the Group Parent
4. Click Save & Close

An administrator can also can manage the viewing levels available on the Hub by following
these steps:
1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down
2. Inside of Members, select the Viewing Level tab and click the New button
3. Add a Level Title and select the Access Groups that have this viewing access
4. Click Save & Close

Points
Points are the Hub’s currency system. Hub administrators can provide royalties to active and
helpful users who interact with a Hub’s community.
Summary: Check out top users and statistics of how points are earned
Look up User Balance: Look up a users Point total by searching with their user I.D.
Configuration: Configure the amount of points you want to reward users when
completing specific tasks which are assigned in the Alias. NOTE: There are only seven
point alias' you can use, see Point Configuration listed below.
Description: Add a short description describing why these points were being
rewarded
Alias: The alias of the rule affliated to the awarded points
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Points: Define the amount of points
Batch Transaction: Deposit or Withdraw points from user accounts through batch
transactions
Configure Points
1.
2.
3.
4.
5.

To set up Points on your Hub, follow these steps:
Log into the /administrator interface
Hover over the Users tab and select Members
Select the Points tab and then the Configuration tab
Fill out the form to add points in seven specific areas of the Hub:
1. Question posted: Award points when a user posts a question
1. Points: Determine the amount of points you want to award a user when
they complete this task
2. Alias: ask
3. Description: Question posted
2. Answer posted: Award points when a user posts an answer
1. Points: Determine the amount of points you want to award a user when
they complete this task
2. Alias: answer
3. Description: Answer posted
3. Question rating posted: Award points when a user posts a rating to a question
1. Points: Determine the amount of points you want to award a user when
they complete this task
2. Alias: questionvote
3. Description: Question rating posted
4. Answer rating posted: Award points when a user posts a rating to an answer
1. Points: Determine the amount of points you want to award a user when
they complete this task
2. Alias: answervote
3. Description: Answer rating posted
5. Answer accepted as best: Award points when a user who asked a question in
Answers accepts another user’s best answer (the user who submitted the
answer earns the points)
1. Points: Determine the amount of points you want to award a user when
they complete this task
2. Alias: accepted
3. Description: Answer accepted as best
6. Abuse report granted: Award points when a user reports abuse and an
administrator grants the abuse report
1. Points: Determine the amount of points you want to award a user when
they complete this task
2. Alias: abusereport
3. Description: Abuse report granted
7. Review rating posted: Award points when a user rates a post
1. Points: Determine the amount of points you want to award a user when
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they complete this task
2. Alias: reviewvote
3. Description: Review rating posted
6. After filling out the form, click Save & Close to save the new point configuration

Passwords
Password Rules and Password Blacklist are two sections that are already set up at default. The
Password Rules comply with our latest security scan and are suggested to be turned enabled at
all times so that all users meet the same rules when creating their accounts. As an
administrator, you can blacklist passwords if you do not want users creating simple or Hub
related passwords.

Blacklisting a Password:
1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down
2. Inside of Members, select the Passwords tab, then select Password Blacklist
3. Click the New button
4. Add the password in the Word text box
5.
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Quotas
Managing user quotas is simplified on the backend into three main areas. As an administrator,
you can increase or decrease a user's quota, create quota classes, and import quotas, by
following these steps:

Increasing/Decreasing a User's Quota:
1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down
2. Inside of Members, select the Quotas tab and select the Member disk quotas tab
3. Search for the user and then click on their name
4. Increase or decrease the user's quota by changing their quota class or by changing their
limits
5. Click Save & Close

Creating a Quota Class:
1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down
2. Inside of Members, select the Quotas tab and select the Quota classes tab
3. Click the New button
4. Fill in the Class Options form
1. Alias: Class alias
2. Soft blocks limit: Soft limit for quota blocks
3. Hard blocks limit: Hard limit for quota blocks
4. Soft files limit: Soft limit for quota files
5. Hard files limit: Hard limit for quota files
6. User Access Groups: Select what access groups are automatically associated
with this quota class
5. Click Save & Close

Importing Quotas:
1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down
2. Inside of Members, select the Quotas tab and select the Import Quotas tab
3. Import existing filesystem quotas by copy and pasting a quota.conf file in the text box
4. Check the box next to Overwrite matching existing entries
5. Click Import
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Registration
An administrator can configure a user's registration fields from the /administrator interface on
the Hub. Read more about this on Member Registration article.

Import
An administrator can manually import users if they are wanting to complete this process for a
large research group needing access to the Hub immediately or for a classroom of students
where the instructor already knows the students' information. To import users and set up import
hooks, follow these steps on the Member Import Article.

Export
Exporting the current list of Hub users can be done by visiting the Export tab inside of
Members. From that tab there will be a button that states Download CSV of all users. By
clicking this button, you can download a list of all members and archive the file for your own use
as an administrator or for safe keeping.

Plugins
Plugins are used to turn on various parts of the Members interface which includes their profile
and dashboard. An administrator can manage these plugins by unpublishing and publishing
various plugins to limit or expand a users Member area on the frontend of the Hub. Specifically
in the Member Dashboard Configuration plugin, an administrator can manually change
rearrange the member dashboard modules to fit the message of the Hub.

Publishing/Unpublishing Plugins:
1. Navigate to /administrator and hover over the Users tab and click on Members from
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the drop-down
2. Inside of Members, select the Plugins
3. Check the box next to the plugin and click the Publish or Unpublish button
4. The plugin will change stats under the Published column

Managing Member Dashboard Configuration:
1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down
2. Inside of Members, select the Plugins tab
3. Locate the Members-Dashboard plugin and click Manage under the Manage column
4. Manage the modules inside of the Members-Dashboard plugin
1. Drag and drop to move modules
2. Drag the lower-right corner to expand or contract the size of the module
3. Add more modules by clicking the Add Modules button and selecting a module
4. Push Modules to Users by clicking this button and filling out the form, then
clicking Push Module
5. All changes will be automatically saved for every new user
1. Users who have already adjusted their Dashboards will not be affected by these
changes
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Registration
Disabling Registration
In some circumstances, it may be desirable to disable user registration entirely. To do so,
navigate to the members manager (Administrator > Users > Members) and click the "Options"
button in the toolbar. The first available configuration option if "Allow User Registration". Set this
to "No" to disable registration entirely.

Registration Fields
1. First log in to the administrative backend
2. Once logged in, find Users in the main menu bar located toward the top of the page.
3. Choose Members from the drop down menu

4. Click on the Registration tab
5. You should now be presented with a table of available user fields and their status for a
particular action. This controls what fields the user will see, must fill in (required) or can
fill in (optional) depending upon which action or state they are currently in. That is, you
can make the username field required for the registration page (create column) but may
not wish for your users to be able to edit this after creation (read only for the
update and edit columns).
Create column: What the user sees on the registration page
Proxy column: What columns an administrator sees or must fill in when creating
an account by proxy (i.e., for someone else)
Update column: What fields the user will see and/or must fill in if something has
changed with what information is required at registration. An example of this
would be if the citizenship field was, at one point, optional for registration but is
now required. Setting this field to Required for the Update column will now
require logged-in users to fill this information out.
Edit column: What fields the user will see and can edit for their user profile
Field Option Definitions:
??Required = Must fill in
Optional = Can fill in, but are not required
Hide = Not visible
Read only = Can view but cannot change
6. Once you feel ready to save your changes, scroll back to the top of the page and click
Save in the upper right portion of the page. Changes take affect immediately.

13 / 29

USERS

Customizing Confirmation Email
All component layouts can be customized through overrides. Except for files that are provided in
the Joomla! distribution itself, this method for customization eliminate the need for designers
and developers to hack core files that could change when the site is updated to a new version.
Because they are contained within the template, they can be deployed to the Web site without
having to worry about changes being accidentally

User Authentication Plugins
A Hub can offer multiple ways for users to login through other services like LinkedIn, Facebook,
ORCID, etc.
Authentication-Certificate: Handles user authentication against client side SSL
certificates
Authentication-Facebook: Handles user authentication against Facebook
Authentication-Google: Handles user authentication against Google
Authentication-Hubzero: Default user authentication
Authentication-LinkedIn: Handles user authentication against LinkedIn
Authentication-ORCID: Handles user authentication against ORCID
Authentication-Picas: Handles user authentication against Purdue's CAS
Authentication-Twitter: Handles user authentication against Twitter

To activate these authentication plugins acquire a customer secret and customer key from the
other service by registering your App on the service and selecting the Web format. Once you
have the keys you can enable the plugins from the backend of the Hub.
1. Navigate to the backend of the Hub and locate the Extensions Tab and click on Plug-in
Manager
2. Inside of the Plug-in Manager, search for the authentication plugin
3. Click on the title of the plugin and inside the plugin insert the customer secret and
customer key
4. Change the Status of the plugin to Enabled and then click Save & Close

TLS Certificate Authentication
Certificate Authentication Plugin:
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This plugin is in charge of actually checking the certificate, and creating new accounts or linking
existing ones to the identity presented in the certificate. With this plugin on, users can login
using their certificate credentials. If a link between those credentials exists, the process is
complete and the user is logged in. If a link does not exist, the user is allowed to create a new
account, thus linking their current certificate to the newly created hub account. A user can also
elect to link their current certificate to an existing account, assuming they are able to provide the
password for that existing account (in the event that someone already has an account on the
system). This plugin is called: Authentication - Certificate.
Enable the Authentication - Certificate Plugin:
1.
2.
3.
4.
5.

Navigate to the backend of the Hub and locate the Extensions tab
Click on the Extensions tab and from the drop-down click on the Plug-in Manager
Locate from the plugin list or through search the Authentication - Certificate plugin
Click on the title of the plugin then locate the Status section inside the plugin
From the Status drop-down, select Enabled then click Save & Close

Certificate routing plugin:
This plugin handles the requirement for a certificate to be present while browsing the site. While
the authentication plugin is what checks and links the user to the cert, other authentication could
still be allowed. With this plugin enabled, a certificate must be present and authentication
options are limited to just certificate based authentication. This plugin is called: System Certificate.

Enable the System - Certificate plugin by following the same steps listed out above.

New account approval:
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This allows admins to require approval of new accounts prior to their being able to access the
site. When this is enabled, accounts pending approval can be found in the users manager on
the backend. You can also elect to turn on an administrative dashboard module that lists
accounts pending approval. And in the users manager parameters, you can enable
administrator notifications to receive an email when new accounts are created. This allows the
certificate->user link to be user initiated (rather than admin initiated), but still gated and admin
approved.
In terms of apache configuration, SSLVerifyClient optional should be set. This will allow the
certificate to be included, but also allow the CMS to handle the requirement for the certificate
through the use of the certificate routing plugin mentioned above.
SSLOptions +StdEnvVars should also be set, as I’m sure it already is for you all. Lastly, make
sure the site is forced to SSL via the Joomla global configuration on the backend.

Note: In order for this feature to be useful, all users need to gain a TLS Certificate and have it
implemented in their browser prior to utilizing this authentication process.
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Member Import
Overview
The members bulk importer/ updater is designed to allow a site administrator to bulk import or
update member data. Due to its ability to mass upload/ modify accounts, it is an administrator
only feature.

Warning!
The improper use of this feature can have damaging consequences. Use with caution.
The importer should only be used in special circumstances. Minimum requirements for the CSV
(first name, last name, username, password, etc.) and any additional registration fields (member
demographics) must be gathered by an administrator for every account to be affected. In most
cases, it is more time effective and less error prone for a new members to enter this information
in the registration form instead of passing the information through the administrator.
Please note, if you are using Member Import on a HIPAA hub, please complete the extra
steps on delivering passwords to members.

Registration Fields
The member importer follows the parameters set in the registration component. If a registration
field is required during the initial registration form (organization, for example), the field must be
included in the uploaded CSV file in addition to the required fields for the CSV. Not all
registration fields are available via the member importer, those should be collected from the new
member on the next login, if desired.

CSV Preparation
1.
2.
3.
4.

Log into hub's administrator portal, e.g. https://hubname.org/administrator
Navigate from the main menu to Users -> Members
From the page menu under the title Members, click on the Import tab
Click on the button that looks like a grid, located on the top right of the page, to
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download the example CSV
5. Save the file with a different name that represents the group of members to be imported
1. Note: Do not save it in Excel format, the import only accepts CSV files.
6. Edit the CSV
1. Fill required fields and any supplementary fields

CSV Field Descriptions
id: User's ID (leave blank when creating new accounts)
name: User's full name e.g. First Last
middleName: User's middle name
surname: User's surname
username: User's hub username
email: User's email (only use valid email addresses as emails will be sent to the user)
password: User's temporary password
block: User's blocked status (1 for blocked, 0 for not blocked)
approved: User's account approval status (1 for approved, 0 for not approved)
sendEmail: User's preference for receiving email from the hub (1 to accept, 0 to decline)
activation: User's email confirmation status (1 for confirmed, 0 for unconfirmed)
usageAgreement: User's acceptance of hub's terms of service (1 for accepted, 0 for
declined)
homeDirectory: User's hub home directory e.g. /home/hub/user
organization: User's organization (depends on hub's registration configuration)
orgtype: User's organization type (depends on hub's registration configuration)
phone: User's phone number (depends on hub's registration configuration)
groups: A comma separated list of the aliases for the groups that the user is a member
of
projects: A comma separated list of the aliases for the projects that the user is a member
of

Creating a new import and uploading a completed CSV
1.
2.
3.
4.
5.
6.

Login to the hub's administrator portal
Click the Members tab and from the drop-down
Click on the Import tab
Click on the button with the plus icon located on the top right of the page
In the new page that opens, enter a name for the import and a short description
Click the file selection button in the Upload fields to upload a CSV file
1. Select the desired CSV
7. Save the import using one of the save buttons in the top right
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Testing an import
It is always a good idea to do a test run before actually importing or updating members'
accounts.
1.
2.
3.
4.

Select the import you wish to test run by checking the box for the import row
Click on the Test Run button
After the test has completed, you will see the results displayed below the progress bar
Click on each item will display details for each record

Running an import (after a test run)
1. Click on the Run for Real button (under the countdown)
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Groups
Overview: Managing Groups
Groups are a unique feature that allows communities to grow inside of the Hub. Groups are
more commonly used to share information between specific individuals. The /administrator
interface allows you to set up permissions for groups and manage active groups all from the
backend of the Hub.

Creating a Group
1.
2.
3.
4.

Navigate to /administrator interface
Hover over Users and select Groups from the drop-down
Click the New button
Fill out the form then click Save & Close
1. Details: General information about the Group
1. Membership: Settings that determine how users can join the new Group
2. Page Settings: General settings that determine Group page setup
3. Email Settings: General email settings that related to emails sent from
the Group
2. Files: A new group must be saved first before you can upload files from the
backend of the Hub and store the files into the Group

Editing a Group
1.
2.
3.
4.

Navigate to /administrator interface
Hover over Users and select Groups from the drop-down
Click the Title of the Group
Change the Group's information then click Save & Close

Deleting a Group
1.
2.
3.
4.

Navigate to /administrator interface
Hover over Users and select Groups from the drop-down
Check the box next to the Group's Title
Click the Delete button
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Publishing a Group
1.
2.
3.
4.

Navigate to /administrator interface
Hover over Users and select Groups from the drop-down
Check the box next to the Group's Title
Click on the Publish button

Unpublishing a Group
1.
2.
3.
4.

Navigate to /administrator interface
Hover over Users and select Groups from the drop-down
Check the box next to the Group's Title
Click on the Unpublish button

Configuring Groups
1.
2.
3.
4.

Navigate to /administrator interface
Hover over Users and select Groups from the drop-down
Click on the Options button
Make changes to the following sections:
1. General: Determine if Groups can be auto-approved or manually approved by
an administrator
2. Info Page: Determine what Groups can show on the Information Page for
Groups
3. Membership & Access: Determine the default discoverability and join policy for
new Groups
4. Email: Enable emailing from the Group from discussion comments and forum
digest
1. Note: If you determine Groups can email out Forum digest you will need
to set up the Cron plugin that sends out these emails
5. Upload: Determine file upload path
6. Pages: Determine if pages need to be approved and who can approve Group
pages, determine other specifics related to Groups
7. Super Groups: Determine if Super Groups can have components, the Super
Group Group Owner and Repo Management options
8. Permissions: Change the viewing and interactive permissions for Groups
5. Click Save & Close to save the changes made
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Access Groups
Access
An area where access groups can be managed. Access groups are the various permission
levels assigned to different groups of users based on their roles in the Hub. Generic default
levels are: Public, Manager, Administrator, Registered, Author, Editor, and Publisher. These
levels are broken up by the levels of responsibility and what the access the group has to
different areas of the Hub. An administrator can see the number of users in the group in the
Users in Group column.

An administrator can add new access groups by clicking the New button and following these
steps:
1. Navigate to /administrator and hover over the Users tab and click on Access Groups
from the drop-down
2. Click the New button
3. Add a Group Title and then select the Group Parent
4. Click Save & Close
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Access Levels
Access
An area where access groups can be managed. Access groups are the various permission
levels assigned to different groups of users based on their roles in the Hub. Generic default
levels are: Public, Manager, Administrator, Registered, Author, Editor, and Publisher. These
levels are broken up by the levels of responsibility and what the access the group has to
different areas of the Hub. An administrator can see the number of users in the group in the
Users in Group column.

An administrator can also can manage the viewing levels available on the Hub by following
these steps:
1. Navigate to /administrator and hover over the Users tab and click on Access
Levelsfrom the drop-down
2. Click the New button
3. Add a Level Title and select the Access Groups that have this viewing access
4. Click Save & Close
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User Notes
Notes
Notes are a function where users can create and store notes on the Hub. On the /administrator
interface, an administrator can manage the notes created by users. This section allows
administrators to manage and view notes make by other users and edit, approve, publish,
unpublish, along with other actions to curate the notes.
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User Note Categories
Categories
Notes are a function where users can create and store notes on the Hub. On the /administrator
interface, an administrator can manage the notes created by users. This section allows an
administrator to create new note categories and batch process selected categories.
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Super Groups
Overview
Super Groups are advanced Hub Groups, that have their own webspace within the Hub to
showcase their Group. Super Groups have a lot of extra functionality built in to allow them to
customize their group.
Super Groups have the ability to include PHP and javascript code into Group pages and
modules. Pages or modules that contain PHP or Javascript code will then need to be approved
by a Group page approver. Notifications are sent to approvers when a page needs to be
approved. Another notification will be sent to the Group managers when the page has been
approved.
Super Group templates must follow HUBzero's Super Group Template rules.

Creating a Super Group

1.
2.
3.
4.
5.

6.

7.
8.

Log in to the backend of the Hub and hover over the Users tab and select Groups
Click New to create a group
Select the group type from the drop-down to be Super
Fill in the CN or group alias, the title and logo of the group, along with the public and
private group descriptions
In Membership Control, check the box if the membership is to be controlled. The
membership Join Policy determines access level for the group
a. Public: Any user on the Hub can join the group.
b. Restricted: Qualifications are given that predetermines who can join. These
restrictions have to be added into the credentials.
c. Invite Only: A group manager has to send an invite any new group members to
the group.
d. Closed: No one can join the group unless they are added from the back-end of
the Hub.
Determine the access level of the group from hidden or visible. A hidden group is not
listed on the front-end of the Hub, and any content is unavailable to any user that is not
a member of the group. A visible group can be found on the Hub through regular
searches
Once all the group’s content has been filled in, then save the new group by
clicking Save & Close. The group will be automatically approved and visible on the Hub
The following will be automatically created when making the super group:
a. Base template with custom error handling & login
b. Separate database for super group related components, data, etc
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c. If Gitlab integration is enabled, all needed connections will be made and super
group folder will be controlled via Git.

Frontend Module Management in Super Groups

Accessing the Module Manager:
1. Log in to the Hub and access the Super Group home page
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page
manager
3. Select the Manage Modules tab to view the module manager
4. Search for modules by using the search drop-down that searches for a module based on
location and title

Adding a Module:
1. Log in to the Hub and access the Super Group home page
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page
manager
3. Select the Manage Modules tab to view the module manager
4. Click the New Module button in the toolbar
5. Fill in all required fields and click Save Page

Publishing a Module:
1. Log in to the Hub and access the Super Group home page
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page
manager
3. Select the Manage Modules tab to view the module manager
4. Publish the module by clicking on the Unpublished icon. The icon will become a
Published icon
5. The module will now be available on the front interface of the Hub
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Unpublishing a Module:
1. Log in to the Hub and access the Super Group home page
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page
manager
3. Select the Manage Modules tab to view the module manager
4. Unpublish the module by clicking on the Published icon. The icon will become an
Unpublished icon
5. The module will now be removed from the front interface of the Hub

Editing a Module:
1. Log in to the Hub and access the Super Group home page
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page
manager
3. Select the Manage Modules tab to view the module manager
4. Click on either the Manage Module button or hover over the arrow next to the button to
see more options, including Edit Module
5. One of the new features with the module manager is the page content WYSIWYG
editor. It now uses CKEditor and HTML to manage your page content
6. Modify the module with new changes, and then click the Save Page

Reordering a Module:
1. Log in to the Hub and access the Super Group home page
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page
manager
3. Select the Manage Modules tab to view the module manager
4. Click on either the Manage Module button or hover over the arrow next to the button to
see more options, including Edit Module
5. One of the new features with the module manager is the page content WYSIWYG
editor. It now uses CKEditor and HTML to manage your page content
6. Modify the ordering of the module by using the drop-down, and then click the Save
Page

Super Groups: Resource Template Inheritance
Originally when viewing a Resource from a Super Group, the Resource is seen with the master
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site template rather than the Super Group's custom template. Resource Template Inheritance
allows users, when viewing a Resource from a Super Group, the Resource to inherit the Super
Group's template to maintain consistent look and feel of the Super Group. '
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